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1.  INTRODUCTION TO ATTIF 

1.1 Overview 

The objective of this manual is to describe the use and capabilities of the computer program 

ATTIF, which can be used in dynamic simulation of multibody system applications, and more 

specifically, railroad train/track interaction. ATTIF (Analysis of Train/Track Interaction Forces) 

systematically treats interconnected rigid bodies utilizing a nonlinear trajectory coordinate 

formulation scheme to provide computationally less expensive simulations without disregarding 

the data accuracy of the analysis. ATTIF provides the ability to simulate accident investigations, 

train configuration evaluations, operating speeds, user-created track scenarios and a variety of 

other features of train/track research interest. The theory used to develop the ATTIF code is 

documented in several texts and published papers which clearly explain the formulations and 

computer algorithms implemented. Using these references, the user can have a comprehensible 

understanding of the structure of the equations of motion used as well as the formulation of 

various force and constraint elements included in the code library. The following chapters 

discuss ATTIF’s features and provide the user with a selection of examples to act as a guide for 

performing their own simulations. It is highly recommended that the user read the entirety of this 

manual to be completely familiarized with the software before performing any simulations. 

 

1.2 Code Structure 

To achieve the goal of computationally inexpensive long-train simulations, ATTIF uses a 

trajectory coordinate system which defines each rail car component’s configuration with respect 

to the body’s trajectory along the space curve of the track, as shown in Fig.1.1. The equations of 

motion for each body of the railcar are then derived using the Newton-Euler equations and 

expressed as trajectory coordinates. These trajectory coordinates are, in turn, used to simulate the 

traction and braking of the railcar. 

 

 
Figure 1.1 - Trajectory coordinates 

 



 
 

The following form of the Newton-Euler equation is used in ATTIF: 
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where im  is the mass of the rigid body; I  is a 3 3  identity matrix; i

I  is the inertial tensor 

defined with respect to the body coordinate system; i

eF  is the resultant of the external forces 

applied on the body defined in the global coordinate system; and i

eM  is the resultant of the 

external moments acting on the body defined in the body coordinate system. 

 

1.3 Installing ATTIF1 

ATTIF is included in the installation of the general purpose multibody dynamics simulation 

software SIGMA/SAMS. Therefore, to use ATTIF, only the installation of SIGMA/SAMS 

necessary. There is no need to install ATTIF independent of SIGMA/SAMS. For instructions on 

how to install SIGMA/SAMS, please refer to the SIGMA/SAMS help manual. 

                                                           
1 Computational Dynamics, Inc. maintains and continues the development of ATTIF. If you have 

any questions, concerns, or are having any difficulty using ATTIF, please contact the 

administrative offices by phone at 630.750.5991 or by email at cdi@computational-

dynamics.com. 

 



 
 

2.  GETTING STARTED 

This chapter provides a brief preface of the ATTIF program for the user to become familiarized 

with the application’s interface. More detailed explanations of each interface option can be found 

in the later sections of this manual.  

 

2.1 Introduction to the ATTIF Interface 

Upon running the ATTIF2000.exe file from the ATTIF directory, located in the folder 

C:\Sams2000\Applications\ATTIF2000, Fig. 2.1 will appear on the computer screen. This is the 

main window of the ATTIF interface, and it is from here that model features can be easily 

created using each respective interface option.  

 

 

Figure 2.1 – ATTIF Main Window 

 

The ATTIF interface is organized into a few basic sections to simplify the process of creating 

and analyzing simulation models. Fig. 2.2 displays the main ATTIF window with marked 

sections of the interface. 



 
 

 

 

Fig 2.2 – ATTIF Interface Main Window Sections 

 

2.2 Main Menus of the Interface 

This part of the manual lists the features and/or capabilities of each menu of the graphical user 

interface. 

     2.2.1 Menu Bar  

     The menu bar includes the basic file options that are found on most common computer                    

programs. 

 2.2.1.1 File Dropdown Menu 

 With the File button a dropdown menu, Fig. 2.3, will appear and the user may: 

 



 
 

Figure 2.3 – File Dropdown Menu 

  1) Create and open a new file:  File →New  

  This creates a new file with the default name AttifModel.dat in the ATTIF   

  directory folder and opens it in the ATTIF interface. The Appendix contains an  

  example data file for reference. 

  2) Open a saved file: File →Open… 

  This option allows the user to select a compatible file to be loaded into ATTIF.  

  After selection, ATTIF immediately reads the file data into the interface. Fig. 2.4  

  shows  the data reading status window that will appear when a previously created  

  file is opened.  This window will display the data that was successfully loaded and 

  any errors it encountered while reading the data. If errors are found, then the  

  file may need to be edited using a basic word editing software such as Notepad.  

  Editing the data files in this way will be discussed in detail in a later section.  

  From the Data Reading Status Window, the Do Not Show Data Reading Status  

  After Successful Data File Readings box can be checked so that this window no  

  longer appears after a file is successfully opened and read into the ATTIF   

  interface.  

 

Fig 2.4 – Data Reading Status Window 



 
 

 

  3) Save file: File →Save 

  Saves the file with the current file name to the same directory it was opened from. 

  THIS WILL OVERWRITE THE PREVIOUS VERSION OF THE FILE. If a  

  new file was created and this is the first time the Save button is selected from the  

  File dropdown menu, the user will be prompted to browse for an appropriate  

  directory to save the file to.  

  4) Save file as: File →Save As… 

  Prompts the user to select a directory and new file name to save the currently  

  opened file as.  

  5) Display print preview of graphics window: File →Print Preview 

  Opens the ATTIF Main Window as a view of what the graphics window will look 

  like when printed. A print option and some other printing options are located on  

  the top command bar in this window. To return to the ATTIF Main Window,  

  select the Close button.  

  6) Display print options: File →Print Setup… 

  Opens a small window with paper, orientation, and margin printing options. 

  7) Print the graphics window: File →Print… 

  Prints the graphics window to the default printer. 

  8) Open and read recently opened files: File →Recent Files 

  Clicking or moving the mouse over this button will cause a dropdown menu to  

  appear to the right, displaying the locations of the four most recently opened files. 

  Selecting one of these files will open and load that file. A prompt window may  

  open asking if the user would like to save the changes of the current file before  

  loading one of the recently opened files.  

  10) Restart the ATTIF application: File →Restart ATTIF 

  Shuts down and restarts ATTIF. A prompt window may open asking if the user  

  would like to save the changes of the current file before restarting. Upon   

  restarting, ATTIF will open at the Main Window. Restarting is required after each 

  simulation of models that include detailed contact.  

  11) Exit the ATTIF application: File →Exit ATTIF 



 
 

  Shuts down ATTIF. A prompt window will open asking if the user would like to  

  save the changes of the current file before exiting. 

 

 2.2.1.2 Edit Dropdown Menu 

 With the Edit button a dropdown menu, Fig 2.5, will appear and the user may: 

 

Figure 2.5 - Edit Dropdown Menu 

  1) Copy graphics window: Edit →Copy Image 

  Attaches a screenshot of the current graphics window to the clipboard. Holding  

  down the left mouse button while the cursor is on the graphics window and  

  dragging will rotate the camera angle of the graphics window. Release the left  

  mouse button at the desired view.  

  2) Export image of graphics window: Edit →Export Image As… 

  Opens a window that prompts the user to select a location, file name, and file type 

  to save an image file of the current graphics window. 

  3) Reset ATTIF application settings: Edit →Reset Application Settings 

  Resets all changed application settings back to their default values.  

  

 2.2.1.3 View Dropdown Menu 

 With the View button a dropdown menu, Fig. 2.6, will appear and the user may: 

 

Figure 2.6 - View Dropdown Menu 

  1) Select interface view by checking/un-checking desired options. Checking Tool  

  Bar will show the Tool Bar, un-checking will hide it. Checking Status Bar will  



 
 

  show the Status Bar, un-checking will hide it. Checking 3D will show the   

  graphics window. Checking Plot will un-check the graphics window and display  

  the selected results plot in place of the graphics window. Checking Split will  

  display the selected results plot on the bottom half of the graphics window  

  with the 3D graphics in the top half. 

  2) Open the Data Reading Status Window by selecting Data Reading Status. Here 

  the Do Not Show Data Reading Status After Successful Data File Readings box  

  can be checked or un-checked depending on user preference.  

 

 2.2.1.4 Data Dropdown Menu  

  With the Data button a dropdown menu, Fig. 2.7, will appear and the user may: 

 

Figure 2.7 - Data Dropdown Menu 

  1) Open a window of the ATTIF directory: Data →ATTIF Directory →Open 

  2) Update all data in the interface panels: Data →Update All Data 

  3) Export the open file to SAMS2000: Data →Export to SAMS2000… 

 

 2.2.1.5 Simulation Dropdown Menu 

  With the Simulation button a dropdown menu, Fig. 2.8, will appear and the user  

  may: 

 

Figure 2.8 - Simulation Dropdown Menu 

  1) Run the currently opened file: Simulation →Run 



 
 

  2) Pause the running simulation: Simulation →Pause 

  3) Stop the running simulation: Simulation →Stop 

  4) Check Run in Real-time mode (recommended) for the graphics window to  

  display the results as soon as the program finds the results data for   

  each time interval. Check Run in Engine Mode for the graphics window to display 

  the results in the time frame of the simulation (i.e. if it takes the train model  

  10 minutes to travel the length of the loaded track, then the graphics display will  

  be 10 minutes long, and the animation is not enabled with that option ). 

 

 2.2.1.6 Results Dropdown Menu 

 With the Results button a dropdown menu will appear, Fig. 2.9, and the user may: 

 

Figure 2.9 – Results Dropdown Menu 

 1) Save results during run-time: Results →Save Results During Run-time 

 This saves the results as they are found during the run-time of the simulation for each 

 time interval. 

 2) Reduce the output size: Results →Output Size Reduction Factor  

 Opens a text box to enter a value for the size reduction factor of the output file. This 

 simply  skips the writing of a certain portion of data points to save space because the  

 output files may become very large (>10MB) for some detailed models. The default 

 value is 1, which writes all data points for each time step. 

 3) Export the simulation results as an ASCII file: Results →Export Results as ASCII… 

 After ending a simulation, selecting this option will open a window prompting the user to 

 select a name and destination folder to save the results files to. It will save the results file 

 in ASCII format and with the default name AttifResults.txt if no new name is entered.  

 

 



 
 

 2.2.1.7 Help Dropdown Menu 

 With the Help button a dropdown menu, Fig. 2.10, will appear and the user may: 

 

Figure 2.10 – Help Dropdown Menu 

 1) View ATTIF application information: Help →About ATTIF… 

 Opens a window displaying the currently installed version of ATTIF and a brief 

 description of ATTIF’s purpose.  

 

     2.2.2 Tool Bar 

     The Tool Bar is a command ribbon below the menu bar that includes a few quick-select       

buttons: 

  1) Create new file button -  

  Creates a new file and loads it into ATTIF interface. A prompt will appear asking user to 

 save current file if one is open and changes have been made after a previous save. 

  2) Open file button -  

  Opens directory browser window to select a file to open and load into the interface.  

 A prompt will appear asking user to save current file if one is open and changes have 

 been made after a previous save. 

  3) Save button -  

  Saves file. THIS WILL OVERWRITE THE PREVIOUS VERSION OF THE FILE. 

  4) Print button -  

  Sends image of the 3D graphic display to the printer. 

  5) Help button -  

  Opens the Help window which displays the application version and ATTIF description in 

. 



 
 

  6) 3D display button -  

  Displays only the 3D graphics of the model in the Graphics Window of the interface. 

  7) Results plot button -  

  Displays only the selected results plot from the Results Tab in the Graphics Window. 

  8) Split screen button -  

  Displays both the model 3D graphics and the results plot in the Graphics Window. 

 

     2.2.3 Panel Buttons 

 

Figure 2.11 – The Panel Buttons 

 The Panel Buttons, Fig. 2.11, are used to switch between the different tabs utilized by the 

user-interface.  

  1) None button – Removes the Data Entry Panel from the display. Whichever display 

 option is selected will be transposed to fit the entire length of the screen.  

  2) Data button – Shows the Data Tab in the Data Entry Panel on the left-hand side of the 

 screen. The Data Tab is used to build models and will be explained in a later section. 

  3) Control button – Shows the Control Tab in the Data Entry Panel. The Control Tab is 

 used to change the setting of a locomotive’s tractive effort engines, break pipes, and 

 coupler activation. It will be fully explained in a later section.  

  4) Results button – Shows the Results Tab in the Data Entry Panel. The Results Tab is 

 used to display selected data on the results plot. It will be explained in detail in a later 

 section of this manual. 

 

 2.2.4 Feature Selection  

 Model bodies and components can be selected through the use of the Feature Selection boxes, 

Fig. 2.12. 



 
 

 

Figure 2.12 – Feature Selection boxes 

 The cars and components created in the file can be selected for editing by either scrolling 

through the features with the arrow buttons or by typing in the number of the desired feature 

in the boxes. These two numbers (car number and component number) also refer to the model 

feature that the Graphics Window is centered on.  

 2.2.5 Status Bar 

 The Status Bar shows the percentage of completion of the loaded file while it is running. 

Directly below the Status Bar, other useful information is also displayed. The simulation time, 

position of the selected feature (from Feature Selection boxes) along the s-axis of the track, 

velocity of the selected feature along the s-axis, and curvature of the track at the point of the 

selected feature are all conveniently displayed for quick reference during simulations. The 

simulation may also be started, paused, or stopped using their respective buttons, Fig. 2.13, 

located directly below the Status Bar. 

 

Figure 2.13 – Status Bar and quick reference data 

 

 2.2.6 Data Input Panels 

 The Data Input Panel is used to build, define, constrain, control, import data, and select 

results. The panel can be switched between Data, Control, and Results using the Panel 

Buttons. The Data Panel contains many tabs which are organized into categories for the 

simple modeling of any necessary features. The Control Panel and Results Panel do not have 

any tabs. These three panels will be explained in greater detail in the next chapter.  

 

 2.2.7 Panel Tabs 

 The Panel Tabs, Fig. 2.14, may be used as an alternative to the previously mentioned Panel 

Buttons. Selection of a Panel Tab will display its respective Data Panel in the Data Input 

Panel section of the interface.  



 
 

 

Figure 2.14 – Panel Tabs 

 

 2.2.8 Graphics Window 

 One of the most useful features of any simulation software is the ability to display the model 

on screen to provide a visual understanding of what is happening. This feature is extremely 

helpful in building models and fixing any present errors. Holding down the left mouse button 

while the cursor is on the Graphics Window and dragging will rotate the camera angle of the 

Graphics Window. Release the left mouse button at the desired view. Remember that the 

Graphics Window will always be centered on the feature indicated in the Feature Selection 

boxes. The center of the Graphics Window (0,0) can be located at the intersection of the two 

white axes (x-axis and y-axis). Gray grid lines are displayed every ten meters along the s-axis 

and y-axis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

3.  LONGITUDINAL TRAIN MODELING IN ATTIF 

This chapter describes the input data required to create a model in ATTIF. A model is defined by 

a collection of bodies, components, kinematic constraints, force elements, and other sets of data 

segments that describe the system inertia, materials, and dimensions. This section gives a 

detailed description for all the standard data for elements that are parts of the ATTIF library. 

 

3.1 Data Entry  

ATTIF includes a simple user-interface that allows model data to be entered into prescribed 

locations amongst the organized tabs, see Fig. 3.1. This section will explain the details of each of 

the Data Tabs. 

 

Figure 3.1 – Data Panel displaying the Cars Tab. Data Tabs and Data Entry Boxes are marked. 



 
 

 3.1.1 Cars Tab 

 ATTIF allows each body to have from one to six degrees of freedom by the user, 

 allowing for simplified train models when the interest is only on the entirety of the train 

 consist. Alternatively, the user may also define fewer but more detailed bodies as 

 articulated cars to analyze derailment and accident scenarios at a closer level, if desired. 

 The combination of these two methods results in a greater knowledge of the interaction 

 forces of long trains.                                                            

 

 Upon opening the ATTIF program and creating a new file, the Cars Tab will be displayed 

 in the Data Entry Panel, Fig. 3.1. This Tab includes the necessary input points for 

 creating each railcar. Directly beneath the marker for the Cars Tab are a few important 

 buttons and boxes, Fig. 3.2. 

 

Figure 3.2 – Cars Tab primary buttons and check boxes 

 1) New 1-Body Car Button– Creates a new single body vehicle and displays it in the 

 graphics window. Use this button for a very simplified car model, where the car body, 

 bogies, and wheelsets are all considered as part of one body by the program and are not 

 treated independently in the simulation. 

 2) New 3-Body Car Button – Creates a new triple body vehicle and displays it in the 

 graphics window. Use this button for a car that treats the car body and the two trucks 

 (bogies) as independent components. The individual components of the body can be 

 selected with the Feature Selection Component box which, by default, assigns the 

 number 0 to the car body, 1 to the rear truck, and 2 to the lead truck.  

 3) Vehicle Type Dropdown Menu – Use this menu to select which type of rail vehicle, or 

 component you would like to model. Vehicles include: Box Car, Flat Car, Locomotive, 

 Tank car, and Hopper Car. Note that the default parameters of these vehicles do not 

 change for different selections, with the exception of the Locomotive. The vehicle’s 

 graphics displayed in the Graphics Window will be the only difference. This menu’s 

 Components include: Truck, Wheel Set, and Frame. Note that these components may 

 only be added to the model as Components, so the New 1-Body Car Button must be 

 selected.   



 
 

 4) Insert After/Insert Before Toggle Button – This button allows bodies and components 

 to be added in to different fashions. If Insert After is displayed, then selecting one of the 

 New Car Buttons will insert the new desired body or component after the currently 

 selected car/component in the Feature Selection boxes. Click Insert After to toggle to 

 Insert Before and vice versa. Insert Before adds the new feature before the selected 

 body/component in the Feature Selection boxes. Note that “After” and “Before” only 

 refer to the assigned car number and component number of the new feature and not the 

 physical location of the feature within the model. By default the new feature’s location 

 will be at the origin and the location must be changed in the Body Sub-Tab.  

 5) To the right of the Insert After/Insert Before Toggle Button are the Copy, Insert, and 

 Delete Buttons, Fig 3.3. The Copy Button is useful for copying the selected Car (this will 

 copy all of the car’s parameters from the Sub-Tabs). After the Copy Button has been 

 pressed the Insert Button will become available and the user may select it to insert the 

 copied Car into the model. The Delete Button will remove the selected Car or 

 Component from the model and remove its displayed graphics from the Graphics 

 Window.  

 

Figure 3.3 – Copy, Insert, Delete Buttons from the Cars Tab 

 6) Add New Body as Component Check Box – Checking this box will add a selected 

 component (Truck, Wheel Set, or Frame) from the Vehicle Type Dropdown Menu as a 

 component of the current Car. Remember that the Insert After/Insert Before Toggle 

 Button still applies. 

 7) Move Components with Main Body Check Box – This box is checked by default and is 

 useful when placing new Cars in your model. The Initial Position of the components will 

 remain in their locations relative to the main body when a new location is entered  for the 

 main body of the car (component 0).  

 8) Add Component as Independent Body Check Box – Checking this box will assign a 

 newly added component its own Car number. Its component number will be 0. 

 

  3.1.1.1 Body Sub-Tab 

  ATTIF allows each component (body) of a car to be customized to the user’s  

  needs. The Body Sub-Tab, Fig 3.4, within the Data Tab includes the main   

  physical attributes of the component.  



 
 

 

Figure 3.4 – Body Sub-Tab 

  Body Information: This section includes the Car number of the selected   

  component, the assigned body number of the selected component in the data file,  

  and a description of the component type.  

  Mass and Inertia: This section is used to input the mass and mass moment of  

  inertia of the body. 

   1.  Mass   The mass of the body (kg) 

   2.  Ixx   The mass moment of inertia about x-axis (kg.m2) 

   3.  Iyy   The mass moment of inertia about y-axis (kg.m2) 

   4.  Izz   The mass moment of inertia about z-axis (kg.m2) 

   5.  Ixy   The product of inertia of x-axis about y-axis (kg.m2) 

   6.  Iyz   The product of inertia of y-axis about z-axis (kg.m2) 

   7.  Izx   The product of inertia of z-axis about x-axis (kg.m2) 

 

  Initial Positions: This section is used to input the initial coordinates that define  

  the initial conditions trajectory coordinates at the beginning of the simulation of          

  the body. 

   1.  S  The initial global s-coordinate of the center of mass (m)  

              2.  Y  The initial global y-coordinate of the center of mass (m) 
   3.  Z  The initial global z-coordinate of the center of mass (m)  

   4.  Roll  The initial rotation angle about the x-axis (radians) 

   5.  Yaw The initial rotation angle about the z-axis (radians) 

   6.  Pitch The initial rotation angle about the y-axis (radians) 

 

 



 
 

  Initial Velocities: This section is used to input the initial velocities at the   

  beginning of the simulation of the body. 

  

   1.  S   The initial global velocity of the center of mass  

      along the x-axis (m/sec) 

   2.  Y   The initial global velocity of the center of mass  

      along the y-axis (m/sec) 

   3.  Z   The initial global velocity of the center of mass  

      along the z-axis (m/sec) 

   4.  Roll   The initial angular velocity about the x-axis   

      (radians/sec) 

   5.  Yaw  The initial angular velocity about the z-axis   

      (radians/sec) 

   6.  Pitch  The initial angular velocity about the y-axis   

      (radians/sec) 

 

  Constant Loads: This section is used to input the constant forces acting on the  

  body. These forces must be defined in the global coordinate system. These  

  constant forces can be used to represent gravity and load forces. 

   

   1.  X   The constant global force acting on the body in the  

      x direction (N) 

   2.  Y   The constant global force acting on the body in the  

      y direction (N) 

   3.  Z   The constant global force acting on the body in the  

      z direction (N) 

   4.  Roll   The constant torque acting on the body about the  

      x axis (N.m) 

   5.  Yaw  The constant torque acting on the body about the  

      z axis (N.m) 

   6.  Pitch  The constant torque acting on the body about the  

      y axis (N.m) 

 

  3.1.1.2 Degrees of Freedom Sub-Tab 

  In ATTIF the Degrees of Freedom (DOF) of a body can be added or removed  

  with ease. The Degrees of Freedom Sub-Tab, Fig. 3.5, located with the Data Tab  

  allows the six DOFs of each body to be included in or removed from the   

  simulation. This feature permits the user to more easily test certain features of  

  their model, while cutting down on computation time.  



 
 

 

Figure 3.5 – Degrees of Freedom Sub-Tab  

  Degrees of Freedom: Check/Un-check each box to add/remove DOF for the  

  selected currently body. 

  User Constant Velocity Constraints: Select/De-Select each circle to add/remove 

  a velocity constraint in the desired direction. These velocities will remain constant 

  for the selected body for the duration of the simulation. For each DOF box  

  checked, a Constant Velocity Constraint may be chosen for that DOF and the  

  desired velocity entered in the box at the bottom of the Sub-Tab. 

 

  3.1.1.3 Resistance Sub-Tab 

  Air resistance is an important consideration when simulating train dynamics over  

  long distances. ATTIF includes resistance formulations to include these forces as  

  part of the simulation. The resistance force models include: rolling resistance,  

  curve, grade resistance and aerodynamic resistance. The rolling resistance is  

  dependent on the vehicle weight, number of axles per vehicle, and the vehicle  

  speed. The physical resistance is effective through the journal and flange of each  

  axle on the railcar. Curve resistance is comparatively similar to rolling resistance  

  in that the motion of the axels experience forces acting against them as they move 

  along a curved track segment and are dependent on vehicle weight, track   

  curvature and resistance. Lastly, the aerodynamic resistance model impedes the  

  motion of the railcar as it moves through the air utilizing the Davis Equation. The  

  Resistance Sub-Tab, Fig. 3.6, lets the user modify the aerodynamic properties of  

  each body. 



 
 

 

Figure 3.6 – Resistance Sub-Tab 

  Aerodynamic Properties: Check/Un-Check Use Resistance Model to include the 

  aerodynamic resistance formulation for the selected body. Choose the body’s car  

  location within the train consist by selecting a position from the Car Location  

  dropdown menu. The X, Y, and Z position (m) of the Area Center of the body  

  may be specified in their respective data boxes for the front and rear of the body.  

  The cross sectional area (m2) may also be specified for the front and rear of the  

  body in the last row data boxes. 

 

  3.1.1.4 Locomotive Engine/Brake Sub-Tab 

  The tractive effort force is the propelling force produced by the locomotive that  

  drives the train. The force is generated through friction between the wheels of a  

  locomotive and the rails of the track. ATTIF includes a locomotive model based  

  off of the Electro-Motive Diesel SD-40-2 locomotive specifications in the vehicle  

  library. This type of locomotive develops the tractive effort forces by combusting  

  diesel fuel to power electric drive motors. Electric propulsion locomotives also  

  utilize dynamic brakes by using the tractive  effort motors in the locomotive to  

  create a torque on the wheels that opposes the motion of the train. ATTIF models  

  this element of the locomotive similarly to the tractive effort, with eight different  

  control positions. When the dynamic brakes  are applied the kinetic energy of the  

  train is converted into electrical energy, which is then dissipated by resistor banks  

  in the locomotives. 

  For each Locomotive in the model, the Locomotive Engine/Brake Sub-Tab, Fig.  

  3.7, will be available. Here the user may change the default parameters of the  

  selected Locomotive.  



 
 

 

Figure 3.7 – Locomotive Engine/Brake Sub-Tab 

  Locomotive Tractive Properties: Check/Un-Check Use Tractive Effort to  

  enable/disable the locomotive’s use of its tractive effort engines which provide  

  the propulsion force of the train. The locomotives in ATTIF are based on the  

  operating characteristics of the Electro-Motive Diesel SD-40-2 locomotive. In the  

  Engine Type Dropdown Menu this locomotive can be selected (the only available  

  choice at this point in development). The throttle position (0-8) of the selected  

  locomotive’s tractive effort engines can be constrained by entering a value from  

  zero through eight into the Throttle Position data box. Three gearing position are  

  available: Forward, Neutral, and Reverse. The position can be chosen in the  

  Reverser Dropdown Menu. Ramping Rate, Scaling Factor, and Threshold Force  

  of the locomotive may also be edited from their default by entering any positive  

  value in their respective data entry boxes. 

  Locomotive Brake Properties: Check/Un-Check Use Dynamic Brake to   

  enable/disable the locomotive’s use of its dynamic brake. Again, the engine type  

  may be selected. The brake position (0-256) may be chosen for the selected  

  locomotive by entering a value into the Notch data box. This will constrain the  

  brake to that position for the duration of the simulation. The Ramping Rate and 

  Scaling Factor can also be assigned using their respective data entry boxes. 

 

  3.1.1.5 Adhesion Sub-Tab 

  Another important aspect of railroad dynamic studies and research is Wheel-Rail  

  Adhesion. ATTIF allows the user to: define wheel and rail surface geometry for  

  railroad applications, find the wheel/rail contacts and to specify the method in  

  which the contact forces should be calculated. There are several three-  

  dimensional formulations implemented in ATTIF that can be used to determine  

  the wheel/rail contact points online. The wheel and rail surface profiles can be  

  defined in ATTIF using a spline function representation. The Adhesion Sub-Tub,  



 
 

  Fig. 3.8, allows the user to adjust the friction coefficients between the Wheel Set  

  and rails. 

 

Figure 3.8 – Adhesion Sub-Tab 

  Wheel-Rail Friction Coefficient: Check/Un-Check Use Adhesion to   

  enable/disable the inclusion of the wheel-rail friction coefficient in the software’s  

  dynamic analysis algorithms. Dry, wet, and sanded rails may be selected and their 

  respective coefficients entered in their corresponding data boxes. The Sanded Rail 

  may be checked for either Dry Rail or Wet Rail. Sand is commonly carried on  

  locomotives and poured along the tracks to help add traction in bad conditions.  

 

   3.1.1.6 Wheels & Axels Sub-Tab 

  The number of axels and its characteristics can be edited from their default values  

  through the Wheels & Axels Sub-Tub, Fig. 3.9, within the Cars Tab of the Data  

  Panel.  

 

Figure 3.9 – Wheels & Axels Sub-Tab 

  Axles: By clicking the arrow a dropdown menus will appear and the user may  

  select the Number of Axels for the selected Car or Component. A value of 2 or 3  

  should be chosen for selected Trucks.  

  Axle and Wheel Data: For each axle of the selected Car or Component, certain  

  parameters may be adjusted in the model. The Axle Half Width (m), Wheel  



 
 

  Radius (m), and X, Y, and Z locations (m, relative to main body) can be assigned  

  by entering values in their respective data boxes.  

 

  3.1.1.7 Brake Sub-Tab 

  Each Car’s Air Brake Car Control Unit (CCU) and specific brake model may be  

  altered within the Brake Sub-Tab, Fig. 3.10. This feature is used to test a brake  

  model’s effectiveness and then to compare with other brake models to optimize  

  performance benefits.  

 

Figure 3.10 – Brake Sub-Tab 

  Brake Model: If a Simple Air Brake is created in the model through the Simple  

  Air Brake Sub-Tab of the Air Brake Tab, then the Brake Model M130 Number  

  selection becomes available in the Brake Sub-Tab of the Cars Tab. Check/Un- 

  Check the Use Air Brake M130 box to enable/disable the inclusion of the M130  

  air brake in the simulation. Use the entry box to assign a marker number to the  

  selected Car’s simple air brake. 

  Car Control Unit Data: As with the Simple Air Brake, if a Detailed Air Brake is  

  created in the model through the Detailed Air Brake Sub-Tab of the Air Brake  

  Tab, then the Car Control Unit Data section becomes available in the Brake Sub- 

  Tab of the Cars Tab. This section includes many inputs that determine the   

  parameter values of the Detailed Brake CCU. All parameters are in the standard  

  International System of Units (SI) units.  



 
 

  3.1.1.8 Graphics Sub-Tab 

 

  An important part of dynamic simulations and a valuable feature of ATTIF is the  

  ability to graphically portray each body’s kinematics within the model.   

  Visualization assists the user in constructing the model and helps make finding  

  modeling errors more inherent. The Graphics Sub-Tab can be seen below in Fig.  

  3.11. 

 

Figure 3.11 – Graphics Sub-Tab 

  Car Body: The graphical representation of the Components in the Graphics  

  Window can be selected using the Car Shape Dropdown Menu. However, only  

  the main body of a car may be changed from its default graphic and   

  measurements. The Length (m), Width (m), and Height (m) of the main body may  

  also be entered. 

  Body Offset from CG: If the user wishes to adjust the location of the graphic of a 

  body within the Graphics Window, then data values may be entered (m, positive  

  or negative) to displace the body’s center of gravity in the Graphics Window.  

  Note that the body’s true center of gravity in the Initial Positions section of the  

  Body Sub-Tab in the Cars Tab will remain the same.  

  

 3.1.2 Couplers Tab 

 Linking multiple cars together in a train necessitates the use of coupler elements. Coupler 

 elements that connect train cars have a significant effect on longitudinal train forces and 

 can significantly influence the stability, derailments and accidents of railroad vehicle 

 systems. It is known that longitudinal train forces during braking, traction, and curve 

 negotiations heavily depend on the design of these couplers, their degrees of freedom, 

 and their ability to absorb impact forces and dissipate energy. As shown in Fig. 3.12, the 

 coupler element consists of a head and shank that can be connected to a flexible unit such 

 as a draft gear or an end-of-car-cushioning (EOC) device which are attached to the car 

 body. 



 
 

 

Figure 3.12 - Coupler Components 

  ATTIF has a new three-dimensional non-linear train car coupler model that takes   

  into account the geometric nonlinearity due to the coupler and car body    

  displacements. The proposed non-linear coupler model allows for arbitrary three-  

  dimensional motion of the car bodies and captures kinematic degrees of freedom that are  

  not captured using existing simpler models. The coupler kinematic equations are   

  expressed in terms of the car body coordinates as well as the relative coordinates of the  

  coupler with respect to the car body.  

 Couplers may be added wherever the user specifies in the train consist and be selected as 

 either a draft gear or an end-of-car cushioning device (EOC), where the energy of the 

 attached components are dissipated by dry friction or fluid damping, respectively. In the 

 formulation used in ATTIF, the model of any particular draft gear is based on force-

 displacement relationships determined using empirical formulas. After  creating 

 vehicles in the Cars Tab, the user may then connect them together by making couplers in 

 the Couplers Tab, Fig. 3.13.  

 



 
 

 

Figure 3.13 – Couplers Tab located by arrow. This figure displays the Simple Coupler Sub-Tab. 

  

 The user must first choose between a simple or detailed coupler, and then select its 

 respective Sub-Tab. Detailed couplers allow the user to specify more thorough 

 information into the Body Data sections for the coupler. To build a coupler the “New” 

 button at the top right of the Sub-Tab must clicked first before entering data. Once the 

 coupler is created use the following sections of the Sub-Tab to define the newly created 

 coupler. A coupler will appear as a small black rectangle in the Graphics Window, see 

 Fig. 3.14 below. 

 



 
 

     

Figure 3.14 – Couplers in the Graphics Window 

 

  Body Indices: Enter the car and component numbers of the bodies that the  

  coupler is linking. 

  Coupler Data: Select what type of coupler you would like in the Coupler Type  

  Dropdown Menu. Couplers may also be made active/un-active by checking/un- 

  checking the check box underneath the Coupler Type Dropdown Menu. Here  

  some basic parameters (all in standard SI units) may be entered for the coupler. 

  Body I Data: ATTIF requires the location on first body (body i) where the  

  coupler is connected to be entered in this section. Also, the direction vectors must  

  be entered, but the default values that appear can be used in most cases. If a  

  detailed coupler was chosen, then ten more parameter values are needed for the  

  coupler model and may be entered into their respective data entry boxes. 

  Body J Data: ATTIF requires the location on second body (body j) where the  

  coupler is connected to be entered in this section. Also, the direction vectors must  

  be entered, but the default values that appear can be used in most cases. If a  

  detailed coupler was chosen, then ten more parameter values are needed for the  

  coupler model and may be entered into their respective data entry boxes. 

  Shank Knuckle/Chassis Data: This last section is only available in the Detailed  

  Coupler Sub-Tab. Here six more parameters are required for the shank knuckle  

  and chassis of the coupler. 

 

 3.1.3 Air Brake Tab 

 Much like the Couplers Tab, the Air Brake Tab, Fig. 3.18, allows the user to create either 

 a simple or detailed air brake model. Whichever type is chosen will be effective for the 

 entire train model. ATTIF integrates an air brake model with efficient train longitudinal 

 force algorithms based on the trajectory coordinate formulations. The air brake model 

 developed in ATTIF consists of the locomotive automatic brake valve, air brake pipe, and 



 
 

 car control unit (CCU) as shown in Fig. 3.15. Using the finite element method, the 

 proposed air brake force model accounts for the effect of the air flow in long train pipes 

 as well as the effect of leakage and branch pipe flows. This model can be used to study 

 the dynamic behavior of the air flow in the train pipe and its effect on the longitudinal 

 train forces during brake application and release.  

 
Figure 3.15 - Main air brake components 

 

 Detailed CCU as shown in Fig. 3.16 is considered. The coupling between the air brake, 

 locomotive automatic brake valve, car control units, and train equations is established and 

 used in ATTIF in the simulation of the nonlinear dynamics of long trains. 

 

 
Figure 3.16 - Car control unit components 

 

 The car brake forces, Fig. 3.17, that depend on the locomotive automatic brake valve 

 handle position and are applied to the wheels using the CCU located along the brake pipe 

 enter into the formulation of the nonlinear train dynamic equations. 



 
 

 
Figure 3.17 - Brake force on a car wheel 

 

 Different computer simulation scenarios have been considered in order to investigate the 

 effect of the air brake forces on the train longitudinal dynamics in the case of different 

 braking modes. 

 

 

Figure 3.18 – Air Brake Tab displaying Simple Air Brake Sub-Tab 

 The user must first choose between a simple or detailed air brake, and then select its 

 respective Sub-Tab. Detailed air brakes allow the user to specify more thorough 

 information for the air brake. To build a air brake for the consist the “New” button at the 

 top right of the Sub-Tab must clicked first before entering data. Once the air brake is 

 created use the following sections of the Sub-Tab to define the newly created 

 coupler. 

  General: Define the number of braked wheels on each vehicle and the auxiliary  

  reservoir volume of the air brake model. 



 
 

  Wheel: Enter data for wheel-rail friction coefficient, inertia and radius. 

  Brake Cylinder: Define the parameters for volume, spring stiffness, piston area  

  and initial spring deformation into their respective data entry boxes. 

  Brake Pad: Define the wheel-pad friction coefficient and wheel-pad gap of the  

  air brake model. 

 Information for the Detailed Air Brake Sub-Tab, Fig. 3.19, is much more extensive than 

 for the simple air brake. This Sub-Tab allows the user to enter specific data for a 

 particular industry air brake model. Default values will appear after the “New” button is 

 clicked, and these values can be helpful if alternative values for certain parameters are 

 not known. 

 

Figure 3.19 – Detailed Air Brake Sub-Tab 

 



 
 

 3.1.4 Track/Spline Tab 

 A vital part of any train model is the track, and the Track/Spline Tab, Fig. 3.20, makes it 

 simple to select and load a track file into the interface. Spline data can also be loaded for 

 models which include wheel-rail contact. 

  

 

Figure 3.20 – Track/Spline Tab 

  Track File: To load a track file into ATTIF first an appropriate .dat file must be  

  opened. The “Open Track File” button will open a browser that allows the user to  

  search for the desired file. If “Open Default Track File” is clicked, then the  

  default track of ATTIF (SamsCrvt.dat) will be opened. Once the track file is  

  opened the file path will be displayed and the track can be loaded by clicking  

  “Load Track Data”. 

  Spline File: As mentioned before, if contact has been included in the model, then  

  spline functions can be utilized in the Track/Spline Tab. The Number of Spline  

  Functions box refers to the number of spline functions defined in the spline data  

  file. This value is typically 3 (for left rail, right rail, and center line splines).  

  Opening a spline file for the loaded track is similar to the procedure for a track;  

  however the spline does not need to be loaded after opening.  

 



 
 

 3.1.5 Recorded Control Tab 

 Tractive effort, dynamic brake, coupler activation, and air brake positions can all be 

 varied throughout a simulation by using the Recorded Control Tab, Fig. 3.21. This Tab is 

 useful in prescribing acceleration/braking scenarios for a model.  

 

Figure 3.21 – Recorded Control Tab 

  Control Data: To create a vehicular control constraint, first click the “New”  

  button at the top right. Then specify what type of control you would like by using  

  the Data to Control Dropdown Menu. The time that the control is applied to the  

  element must be entered into the Time box. Element Number refers to which  

  locomotive the control is being set for, where Element Number 1 is the   

  locomotive with the lowest assigned Car Number and 2 is the second lowest, etc.  

  Values for the selected control data may then be entered into the third data box.  

  Descriptions of the control will be displayed in the Description text box which  

  contains the allowed values for each type of control.  

 

 3.1.6 Springs Tab 

 One of the most common vibration control elements is the linear spring. The ATTIF 

 interface allows the user to define springs to study railcar suspension systems by using 

 the Springs Tab, Fig. 3.22. 



 
 

 

Figure 3.22 – Springs Tab displaying default values for a newly created spring 

  Springs do not require much data to define and the process is similar to the  

  procedure to create couplers which was explained previously. These elements will 

  not appear in the Graphics Window. 

 

 3.1.7 Bearings Tab 

 Another suspension/vibration reduction element that is available to the user is a bearing. 

 Bearings may be added in one direction between two bodies in the Bearings Tab, Fig. 

 3.23. These elements will not appear in the Graphics Window. 

 

Figure 3.23 – Bearings Tab 



 
 

  Bearing data is entered the same way as in the other Tabs. Always be sure to  

  check body dimensions in the Cars Tab to verify the locations of your suspension  

  elements. 

 

 3.1.8 Simulation Parameters Tab 

 The eighth tab of the Data Panel is the Simulation Parameters Tab, Fig. 3.24. This Tab 

 includes very important settings that the user must be sure to check to have a successful 

 simulation.  

 

Figure 3.24 – Simulation Parameters Tab 

  Numerical Settings: The Time Step of the simulation is defined as the results  

  printing interval between each successive execution of the software’s   

  mathematical algorithms. This value will greatly affect the computational time of  

  the simulation and therefore must be adjusted accordingly. The Simulation Start  

  Time and Simulation End Time must also be entered in this section as well as the  

  Relative Tolerance and Absolute Tolerance of the integrator.  

  Number of Points to Skip: This section defines the number of time step points  

  that the Graphics Window will skip in order to speed up the graphics display.  

  Note that this does not affect computational accuracy. 



 
 

  Data Updater: The buttons in this section of the Simulation Parameters Tab may 

  be used to update the existing data of various features of the model. 

 3.1.9 3D Window Settings Tab 

 The Graphics Window is a convenient feature for constructing and visually evaluating a 

 model. However, if the default settings are not optimal, then they may be changed in the 

 3D Window Settings Tab, Fig. 3.25. The default settings will typically be enough for the 

 majority of simulations. 

 

Figure 3.25 – 3D Window Settings Tab 

 

 3.1.10 Bushing Tab 

 The third available vibration reduction element is the bushing. Bushings reduce friction  

 between bodies in three dimensions and may be added to a model in the Bushing Tab,  

 Fig. 3.26. 



 
 

 

Figure 3.26 – Bushing Tab 

 Data for bushings are similar to the previously discussed suspension elements with the 

 exception that bushings may be attached across multiple planes. The second row of x, y, 

 and z coordinate boxes in the Body J Data section allow the user to define a second point 

 on Body j that the bushing’s center is aligned with.  

 

 3.1.11 Pin Joint Tab 

 A pin joint (also known as a revolute joint) is a two constrain a pair of bodies to one 

 degree of freedom about a single axis of rotation. The Pin Joint Tab, Fig. 3.27, allows the 

 user to employ this mechanical feature in a model. As with the bushing element, a pin 

 joint may be created in any direction from the first body to the second body by creating 

 lines with each row of attachment coordinates. 



 
 

 

Figure 3.27 – Pin Joint Tab 

 

 3.1.12 Contact Tab 

 The last Tab of the Data Panel is the Contact Tab, Fig 3.28. This tab is essential in 

 creating models where there is wheel-rail contact involved. A new contact must be 

 created for each wheel that the user wants to include contact for. This can become a 

 lengthy process for large, detailed models, but by using and familiarizing yourself with 

 this Tab it will become much easier to properly define all the necessary contact points 

 for your model. The Appendix contains an example input data file which includes wheel-

 rail elastic contact. 



 
 

 

Figure 3.28 – Contact Tab 

  Contact Body Indices: After creating a new contact by clicking the “New’  

  button, the Body Number and Component Number of the element to be in contact  

  with the rail must be entered in the appropriate data box. 

  Contact Parameters: ICMOD and JCMOD indicate the method that will be used 

  to define the profile of Wheel/Rail respectively and for the current version the  

  Spline is the only choice. ICSPL and JCSPL specified the Spline function number 

  that will be used by Wheel/Rail respectively. ICREP is flag used to define the  

  creep force model. 

  Contact Profile: S1(Wheel) and S2(Wheel) are initial value of lateral and angular 

  wheel surface parameters. S1(Rail) and S2(Rail) are initial value of longitudinal  

  and lateral rail surface parameters. RX(Wheel), RY(Wheel) and RZ(Wheel) are  

  the x, y, z position of the origin of the surface coordinate system on the wheel  

  with respect to the body coordinate system. RX(Rail), RY(Rail) and RZ(Rail) are  

  the x, y, z position of the origin of the surface coordinate system on the rail WRT  

  the body coordinate system. Wheel center is the lateral distance of the wheel  

  center to the wheelset center of gravity. 



 
 

  Contact Creepage: ICRV is the creep force model which the user can refer to in  

  the ICREP. EWheel/Rail, GWheel/Rail and PWheel/Rail are the elastic modulus,  

  shear modulus and Poisson ratio of the Wheel/Rail respectively. Psi is the angle  

  between the normal planes that contain the 1/RRW (principle rolling radius of the  

  wheel) and 1/RRR (principle rolling radius of the rail). Flang. Fric. Coef. is the  

  coefficient of friction of the flange contact. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

4. Model Examples 

This chapter will reinforce the material of the previous chapters through step-by-step examples 

of how to best use the interface to create, simulate, and analyze an ATTIF model. Following an 

example while simultaneously using ATTIF to create the example will be valuable in 

familiarizing yourself with the software.  

 

4.1 Example #1: 5 car consist of 1-Body vehicles 

This example gives a brief introduction to the most common features of ATTIF. The model 

created will be very simple, but this example is a good start to learn how to utilize the 

application. Follow along with the subsequent steps to build, simulate and analyze a 5 car consist 

of 1-Body rail vehicles. 

 Step 1: Open ATTIF by running the ATTIF.exe file on your computer. Upon opening

 the main ATTIF window will be displayed.  

 

Fig. 4.1 – Main ATTIF Window 

 Step 2: To begin building the model we must first create a new file for the data to be 

 written to. Do this by selecting New from the File Dropdown Menu, or by clicking on the 

 Create New File Button from the toolbar. After you do this, some of the data buttons in 

 the Data Entry Panel will no longer be grayed out, and any entered data will be written to 

 the new file you have created. Note that the file is automatically named Attifmodel.dat as   



 
 

    
Fig 4.2 – Create New File Button 

 

 Step 3: To create the first car of the model click on the New 1-Body Car button in the 

 Cars Tab of the Data Entry Panel. A box car should now appear in the Graphics Window 

 and its default data will occupy the data boxes of the opened Tab. The image below 

 shows the results of this step. This body of this first car starts at the origin which is the 

 intersection of the two white lines in the Graphics window. This is the position we wish 

 for it to be in, so we will not make any changes to its default data. Also, note from the 

 Degrees of Freedom Sub-Tab that the model is constrained to the S direction (see Fig. 

 4.4). 

 

Fig 4.3 – New 1-Body Car Button 

 



 
 

      
Fig 4.4 – Degrees of Freedom Sub-Tab 

 

 Step 4: To create another car click the New 1-Body Car button. A second 1-Body box car 

 with default parameters will now be written to the data file. Note that the Graphics 

 Window will still show only one box car. This is because the second car is in the exact 

 same position as the first car we made. We will relocate it in the next step. Also note the 

 Feature Selection Boxes, the number 2 should now be displayed next to Car. Remember 

 that the arrows can be used to move between Cars and components to edit data. Fig 4.5 

 below shows this step and references the Feature Selection Boxes. 

 

 
Fig 4.5 – Feature Selection Boxes 



 
 

 Step 5: We must now edit the parameters of the second car to the needs of the desired 

 model. First, change the location of the car by entering 20 into the S data box in the 

 Initial Positions section. For the value to be applied, click in another data box and you 

 will see the car relocate in the Graphics Window to the entered position. This will move 

 the center of gravity (CG) of the vehicle to this position in the S-direction (remember that 

 this is the same as the x-direction in the standard Cartesian coordinate system). The 

 image below shows the new initial position of Car 2 and the 2m gap between the two 

 cars. Since the vehicles are both 12m long (Fig.4.7), the CG of Car 2 being at 20m will 

 leave a 2m gap after the first car. The Graphics Sub-Tab shows how long each vehicle is 

 and can be edited there as well. Also remember that you may change the view of the 

 Graphics Window by holding down the left mouse-button over the Graphics Window and 

 dragging then releasing at the desired position. 

 

Fig 4.6 – Initial Positions Data Entry Boxes 



 
 

            
Fig 4.7 – Vehicle Graphics Sub-Tab 

 

Step 6: Now that the first two cars have been built, follow the steps that we used to create 

 the second car and build a third and fourth box car at 34 and 48m along the S-direction, 

 respectively. The image below should result and there should be a 2m gap between each 

 consecutive car. 

 

 
Fig. 4.8 – Four Box Cars in Graphics Window 

  



 
 

Step 7: With Car 4 selected in the Feature Selection Box, create a locomotive by  selecting 

 ‘locomotive’ from the Vehicle Type Dropdown Menu and clicking the New 1-Body 

 Car button. This will make a locomotive and display it at the origin in the Graphics 

 Window. Set its S initial position to 66m (the locomotive is 20m long). You should now 

 have the image displayed below in Fig. 4.9 showing the locomotive (Car 5) in the lead 

 position of the consist. 

 

 
Fig. 4.9 – Locomotive Initial Position 

 

 Step 8: The next important feature we must add are couplers. One coupler must be 

 created between each set of cars to transfer the motion of the locomotive to the trailing 

 cars of the consist. Select the Couplers Tab in the Data Entry Panel to begin creating the 

 four necessary couplers for this model. Click the New button in the Couplers Tab to 

 create the first coupler and un-gray the data boxes within the Tab. The image below 

 shows the new coupler with its default data values and its location in the Graphics 

 Window. Car I should automatically be set as Car 1 and Car J as Car 2 in the Body 

 Indices Section of the Tab. Notice that the cars are not connected by the coupler because 

 its default undeformed length does not cover the 2m gap we left between the box cars. 

 Change the undeformed length to 2m and watch the Graphics Window to see the change. 

 The images below show the coupler with the default undeformed length and then the new 

 length that we have just entered. Keep all the other parameters of this coupler as their 

 default. The Z Attachment Points Relative to Body CG are displayed in the Graphics 

 Window at the CG point until the simulation begins when, in this model, they will 

 immediately move -1.624m downwards at t=0.0 seconds and connect the vehicles 

 appropriately.  



 
 

 

Fig 4.10 – Default Coupler Undeformed Lengths 

 

 

Fig. 4.11 – New Defined Coupler Undeformed Lengths 

 



 
 

 Step 9: Now the three other couplers must be created. Click the New button in the 

 Couplers Tab again and set Car I as Car 2, Car J as Car 3, and an undeformed length of 

 2m. For the third coupler we will follow the same procedure. Click the New button and 

 set Car I as Car 3, Car J as Car 4, and the undeformed length as 2m. Remember that you 

 can use the Coupler Number arrow buttons at the top left of the Couplers Tab to select 

 which coupler’s data is displayed in the panel. Notice that if you create a new coupler 

 while having a coupler selected that is not the largest coupler number in the model, then 

 this will create a coupler with an assigned number of one greater than the currently 

 selected coupler (e.g. if coupler 2 is selected and there are 4 couplers in the model and 

 you click New, then this new coupler will be Coupler Number 3 and Coupler Numbers 3 

 and 4 will be reassigned as 4 and 5, respectively). This only affects the order in the data 

 file and will not change the entered parameters. For the last coupler required we need to 

 connect the fourth box car (Car 4) with the locomotive (Car 5). Click New and set Car I 

 as Car 4, Car J as Car 5, and the undeformed length as 2m. If you adjust your Graphics 

 Window to visualize this last coupler, then you will notice that it is not completely 

 connecting the two vehicles. This is because the locomotive longer than the box cars and 

 so the default value for the X Attachment Point Relative to Body J CG in the Body J 

 section must be edited to -10m. See Fig. 4.12 below for the graphics we now have for 

 the model with the edited X Attachment Point Relative to Body J CG value for the 

 locomotive referenced.  

 
Fig. 4.12 – Local Coupler Attachment Point On Locomotive 

 

 

 Step 10: Because all of the bodies in this model are constrained to just the S-direction it 

 will not need any connections or suspension features that act in the vertical (z) or lateral 

 (y) directions. So now we will edit the initial velocities of each car. Do this by selecting 

 the Cars Tab → Body Sub-Tab → Enter 16 into the S data box of the Initial Velocities 

 Section. This will set the initial velocity of the vehicle to 16m/s in the S-direction. Now 

 use the Feature Selection Boxes to edit the S Initial Velocities on the four other rail cars 



 
 

 to 16m/s. The image below shows the new value for the s-direction initial velocity of the 

 locomotive. 

               

Fig. 4.13 – Body Sub-Tab in the Cars Tab of the Data Panel 

 

 Step 11: The consist is now complete. However, we still need the track. To load a track 

 file into ATTIF, first open the Track/Spline Tab in the Data Entry Panel. Then either 

 click the Open Track File button to browse for the desired file or click the Open Default 

 Track File button to open ATTIF’s default track file (Samscrvt.dat). After you have made 

 your selection, click the Load Track Data button. Now the track will be loaded into the 

 data file and its graphic will be displayed (beginning at the origin) in the Graphics 

 Window. Note that the Data Reading Status Window may appear when the track file is 

 loaded, and recall that this may be prevented from appearing again by checking the Do 

 Not Show Data Reading Status After Successful Data File Readings box at the bottom of 

 the window. For this example no Track Curve Number is necessary because we are not 

 using splines files and contact, so leave this data box blank. Fig. 4.14 shows our 

 completed consist with the loaded default track file.  



 
 

 
Fig. 4.14 – Completed Consist With Loaded Track Data 

 

 Step 12: For good measure it is always important to check the Simulation Parameters 

 Tab in the Data Entry Panel before beginning a simulation. Here the Time Step, 

 Simulation Start and End Times, and Tolerances may be changed from their default. 

 Also, the Number of Points to Skip may be edited. Enlarging this value will greatly 

 increase the speed at which the simulation is executed. For now, leave everything in this 

 Tab at its default. The Simulation Parameters Tab can be seen in Fig. 4.15 below. 



 
 

 

Fig. 4.15 –Simulation Parameters Tab 

 

 Step 13: If you have followed all of the preceding steps correctly, then you are now ready 

 to run the simulation of this example. First, go to the Menu Bar and bring up the Results 

 Dropdown Menu and make sure that Save Results During Run-Time is checked. To begin 

 the simulation, you may select Run from the Simulation Dropdown Menu in the Menu 

 Bar or simply click the big blue arrow directly above the Graphics Window. After 

 choosing one of these options, the interface will automatically open a window asking you 

 to save the file because you have changed it from the default new file you originally 

 created in Step 2. Chose the desired name and directory location of the file for this model 

 and then click Save. The simulation will now commence until one of three things occur: 

 the Simulation End Time is reached, the entire length of the track is traveled by the lead 

 vehicle in the consist, or until an error occurs in the execution of the data file. Note that 

 the simplicity of this model may cause it to run very quickly. Once the simulation has 

 ended an alert window will appear. Click OK to close this window. Then click the blue 

 square above the Graphics Window to stop the simulation. Although the simulation may 

 have already finished, you need to click this  button to view the results or to run the 

 simulation again.  

 Step 14: You may now view the various results plots of the simulation we just completed 

 by selecting the Results Button below the Toolbar. Click the Split screen button on the 

 Toolbar to bring up a plot area on the lower portion of the Graphics Window, or the Plot 

 button to replace the entire model display in the Graphics Window with the results plot. 



 
 

 Now check the Use the Saved Results As Data Source box, and select the desired data to 

 plot from the Plot Data Dropdown Menu. You should now see the S-coordinate plot of 

 Car 1 in the plot area of the Graphics Window. The X and Y Limits of the plot will be 

 automatically adjusted by the program. If you wish to adjust the plot more appropriately, 

 then you may utilize the Range section of the Results Data Panel to change the 

 minimums, maximums, and grid spacing of the x and y-axes of the plot. Other data for 

 different cars, components, and coordinate directions may be chosen as well using their 

 respective selection boxes. The image below shows the S-coordinate results plot of the 

 rear box car (Car 1) for the simulation. Note that your results may be slightly different in 

 the case that the default track that you loaded is not exactly the same length or shape 

 that I have used for this manual.  

 
Fig. 4.16 – Results Panel With S-Coordinate of Car 1 vs. Time Plot 

 

Congratulations you have just finished your first longitudinal train dynamics simulation in 

ATTIF! There are still many more features we will cover in the next few examples to help you 

utilize each one more affectively in your simulations. Continue with the next examples to learn 

more about suspension elements, locomotive control features, and wheel-rail contact.  

 

 



 
 

4.2 Example #2: 15 car consist of 3-Body vehicles 

This second example will familiarize the user with 3-Body vehicles, suspension components, and 

locomotive control features. Because this consist will include 15 vehicles, creating all of them 

will become very repetitive and so we will use tables to reference the correct parameters of the 

vehicles rather than going through each one step-by-step. This example also assumes that the 

user as already read the first example in the manual to prevent redundancy in each step. 

 Step 1: Open ATTIF and create a new file.  

 Step 2: In the Cars Tab of the Data Entry Panel select ‘Box Car’ from the vehicle type 

 dropdown menu and then click the New 3-Body Car button. After doing so, the following 

 image should result. Notice that the data for Component 2 is displayed. ATTIF assigns 

 Component 0 to the main body of the vehicle, Component 1 to the rear bogie, and 

 Component 2 to the lead bogie. The default location for this first vehicle is acceptable for 

 this model and we will not adjust it. 

 
Fig. 4.17 – Car 1 of Example #2 

 Step 3: To create the second vehicle, we need to make a few checks before we add it to 

 the interface. First be sure that Insert After is displayed next to the Copy button, this will 

 any newly created bodies after the presently selected body. Because we wish to add the 

 next vehicle after the one we just created, be sure that you have Car 1/Component 2 

 selected in the Feature Selection Boxes (see above figure). Lastly, the only box in the 

 Cars Tab that should be checked is Move Components with Main Body. Now click New 

 3-Body Car again to create the second Box Car. In the case that Insert Before was 

 displayed rather than Insert After, the below error message will appear. This results 

 because the new body cannot be added in between to existing components of a car. This 

 error will also appear if the last component of the vehicle is not selected.  



 
 

 

Fig. 4.18 – ATTIF Error Warning 

 Step 4: Remember from the first example that when we added the second car that it is 

 added in the default location (beginning at the origin), and thus cannot be seen until 

 new initial positions are defined. To make this easier be sure you have the Move 

 Components with Main Body box checked, as this will keep the bogies in their relative 

 positions of the main body. Now select Component 0 of Car 2 from the Feature Selection 

 Boxes and enter 19.5 for its S initial position. This should move the entire car (main body 

 and 2 bogies) in front of the first car. The figure below displays what you should now 

 have for your model. 

 

Fig. 4.19 – Car 2 of Example #2 

 Step 5: For this step use what you have learned to create the next 13 vehicles listed in the 

 following table. Remember to always have Insert After displayed and Component 2 

 selected of the most recent Car that you have created so that no errors will occur when 

 you click New 3-Body Car to create the next vehicle in the consist (e.g. when creating the 

 third car have Car 2/Component 2 selected). The vehicle will still be created at the default 

 initial position, so have the Move Components with Main Body box checked so that you 

 only have to enter a new initial position for the main body and not the bogies as well. 

 Note that the lead bogie is typically +4.32m from the CG of the main body, and the rear 

 bogie is -4.32m for any vehicle other than a locomotive (±6.096 for a locomotive).  



 
 

 
Fig. 4.20 – Example #2 Vehicle S Initial Positions 

 Step 6: You may have had some trouble creating all of the Cars in the previous step. To 

 delete a 3-Body Car, select Component 2 of the Car and click the Delete Button in the 

 Cars Tab. This will remove the lead bogie of the car. Then select Component 1 and click 

 Delete to remove the rear bogie. And again, select Component 0 and click Delete to 

 remove the main body. In the case that you did not delete the two bogies before clicking 

 the Delete button while having the main body selected, the following error message will 

 appear. 

 
Fig. 4.21 – Component Error Message 

 At this point you should have all 15 Cars in there correct initial positions (1.5m spacing 

 between each vehicle). The figure below shows the Graphics Window.  



 
 

 
Fig. 4.22 – Example #2 Consist 

 Step 7: As in the previous example, we need to attach each vehicle pair by creating 

 couplers. We will again use simple couplers for this example. Only change the Car 

 Numbers, Component Numbers, and X Attachment Point Relative to Body CG for each 

 car. All of the other parameters will be kept at their default. The undeformed length will 

 not need to be changed because its default value is 1.5m. Use what you learned in 

 Example #1 and the table below to use the interface to create the 14 necessary simple 

 couplers for this example. 



 
 

 
Fig. 4.23 – Coupler Attachment Data for Example #2 

 Step 8: Now that each vehicle is connected by a coupler, we must connect each car’s 3 

 components together. For this we will utilize bushing elements in the Bushing Tab of the 

 interface. To keep this example simple, each standard car will have two bushings (one 

 connecting the rear bogie to the main body, and one connecting the front bogie to the 

 main body) and each locomotive will have four (two for the rear bogie, and two for the 

 front bogie) for a total of 36 bushing elements for this example. The figure below shows 

 the Bushing Tab. 

 
Fig. 4.24 – Bushing Sub-Tab 



 
 

  Body Indices: This section is used to enter the bodies that are connected by the  

  bushing element. 

  Body I Data: The Attachment Points Relative to Body I CG can be entered here.  

  Body I corresponds to the component number entered for Car I.  

  Body J Data: The Attachment Points Relative to Body J CG can be entered here.  

  Body J corresponds to the component number entered for Car J. The second row  

  of coordinates (X2, Y2, Z2) are used to create a line that the bushing’s center is  

  aligned with.  

  Bushing Stiffness:  

   1. Kx   Stiffness in the x-direction (N.m) 

   2. Ky   Stiffness in the y-direction (N.m) 

   3. Kz   Stiffness in the z-direction (N.m) 

   4. Kph   Stiffness about the x-axis (N.m) 

   5. Kth   Stiffness about the y-axis (N.m) 

   6. Kps   Stiffness about the z-axis (N.m) 

   

  Bushing Damping:  

   1. Cx   Damping in the x-direction (N.s/m) 

   2. Cy   Damping in the y-direction (N.s/m) 

   3. Cz   Damping in the z-direction (N.s/m) 

   4. Cph   Damping about the x-axis (N.s/m) 

   5. Cth   Damping about the y-axis (N.s/m) 

   6. Cps   Damping about the z-axis (N.s/m) 

 

  Bushing Preload Forces: 

   1. Fx   Force in the x-direction (N) 

   2. Fy   Force in the y-direction (N) 

   3. Fz   Force in the z-direction (N) 

   4. Tph   Force about the x-axis (N) 

   5. Tth   Force about the y-axis (N) 

   6. Tps   Force about the z-axis (N) 

 

 To create a bushing, click the New button in the Bushings Tab. The information required 

 to successfully create the 36 bushing elements in this example are tabulated below. They 

 will all be fitted in the z-direction (vertical). The stiffness, damping, and preloads are the 

 same for all bushings. Note that values may be entered using power multipliers (e.g.10e6 

 may be entered into the data boxes for an equivalent entry of 10,000,000). 

 

 



 
 

 
Fig. 4.25 – Bushing Stiffness, Damping, and Force Data 

 

 
Fig. 4.26 – Bushing Attachment Data for all Example #2 Bushing Elements 

  

Step 9: In the Cars Tab and Body Sub-Tab, set each component of each cars’ S Initial 

Velocity to 1.0m/s. Use the Feature Selection Boxes to scroll through each of the three 

components of the car (0-2) and each of the fifteen cars. It is useful to set a small initial 

velocity for each body because the program’s algorithms sometime encounter errors 

when divisors are equal to zero which can be a result of the velocity being zero. Fig. 4.27 

shows the new S Initial Velocity for Car 1 Component 0.  

 

 



 
 

                      
Fig. 4.27 – Body Data for Car 1 Component 0 

 

 Step 10: Now that the suspension and couplers are in place, the model is nearly complete. 

 For this example we wish to include some acceleration and braking. To do this we will   

 utilize Recorded Control which sets periods of tractive effort and dynamic braking of the 

 locomotives in the consist. First check that Use Tractive Effort and Use Dynamic Braking 

 are checked in the Locomotive Engine/Braking Sub-Tab of the Cars Tab for Cars 5,10, 

 and 15 (the three locomotives). See the figure below of the Locomotive Engine/Braking 

 Sub-Tab. 

 

 
Fig. 4.28 – Locomotive Engine/Brake Sub-Tab 



 
 

 Step 11: To add recorded control, go to the Recorded Control Tab then click New to 

 create the first control. Choose Throttle Position – Tractive Effort from the Data to 

 Control Dropdown Menu, Time 1.0, Element Number 1, and Value 8. This will set the 

 tractive effort of locomotive 1 (Car 5) to its maximum level (8) at 1.0s of the simulation. 

 Fig. 4.29 below shows the Recorded Control Tab with the first control for this example. 

 

 
Fig. 4.29 – Recorded Control Tab 

 

 Add the controls in the following table to complete the Recorded Control for this model. 

 Note that with this control the consist will begin accelerating at 1.0s until 240.0s when 

 the tractive effort ceases, and then it will coast until 360.0s when full dynamic braking 

 (256) is activated and the train will decelerate to a stop.  

 

 

Fig. 4.30 – Recorded Control Data for Example #2 

 Step 12: We need to change the resistance model for the first and last car in the consist in 

 the Resistance Sub-Tab of the Cars Tab. Middle Car is the default in the Car Location 

 Dropdown Menu. But the lead locomotive (Car 15) and trailing box car (Car 1) are not in 

 between two other railcars, so their aerodynamic models must be properly adjusted. 

 Select First Car for Car 15 and Last Car for Car 1from the Car Location Dropdown 

 Menu.  

 Step 13: The train is now complete. Open and load a track (preferably a very long one 

 since our consist will be running for few minutes).  



 
 

 Step 14: Check the Simulation Parameters Tab in the Data Entry Panel to be sure that 

 everything there is how you would like it. This model contains many more elements than 

 in our last example, so it is likely that the simulation may run very slow depending on the 

 computing power of your computer. Adjust the Number of Points to Skip section 

 appropriately (as a suggestion, start with 50). 

 Step 15: Select Run from the Simulation Dropdown Menu in the Menu Bar or click the 

 dark blue triangle to begin running the simulation.  

 

4.3 Example #3: 15 Consist including one 7-Body Car with Wheel/Rail Contact 

In this third example, wheel/rail contact will be added to a single detailed car within a 15-car 

consist. The idea is that the detailed contact model can be used to analyze railcars at different 

positions in the train while keeping the rest of the cars as simple as possible in order to reduce 

computational time. Please follow the series of steps below to become acquainted with this 

important feature.  

 Step 1: Open ATTIF and create a new file. 

 Step 2: Select Tank Car from the Vehicle Type Dropdown Menu and click New 3-Body 

 Car. This car will be our detailed car, but first it needs some modification. 

 Step 3: Delete the two bogies (Components 1 and 2 of Car 1) from the tank car and 

 assign the tank car main body (Component 0 of Car 1) to 95m Initial Position in the S 

 direction. 

 Step 4: Now we need to add the detailed components of the two bogies we just deleted. 

 Start by checking the Add New Body as Component box (see Fig. 4.31 below).  

 



 
 

 
Fig. 4.31 – Main Body Component of Car 1  

 Step 5: Select Wheelset from the Vehicle Type Dropdown Menu and click New 1-Body 

 Car. This will add the first wheelset of the Detailed Car as Component 1. Set its S Initial 

 Position to 90m.  

 Step 6: Repeat Step 5 three more times so you have a total of four wheelsets at 90, 91.5, 

 98.5, and 100m. The wheelsets should be Components 1-4.  

 Step 7: To add the frames to the model, select Frame from the Vehicle Type Dropdown 

 Menu and click New 1-Body Car. Do this twice and place the first frame (Component 5) 

 at 90.75m and the second (Component 6) at 99.25m.  

 Step 8: Once your frames are in place go to the Graphics Sub-Tab for each frame and 

 adjust their lengths to 1.5m. The results of this step can be seen below. 

 
Fig. 4.32 – Detailed Car Component Graphics 

 

Graphic 

Length 



 
 

 Step 9: Our Detailed Car now has all of its components in the proper place. Un-check the 

 Add New Body as Component box and select Car 1/Component 6 using the Feature 

 Selection Boxes. Now create the fourteen other vehicles (all 1- Body) listed in the 

 following table. Make sure that when you are adding each new vehicle that you have the 

 previously created car selected before you click New 1-Body Car so that they do not 

 become disordered.  

 
Fig. 4.33 – Example #3 Car S-direction Initial Positions 

 Step 10: Add the simple couplers in the next table using the Couplers Tab. For coupler 

 numbers 6 and 7, be sure to specify attachment of the coupler to component 0 for all cars. 

 All other default parameters for the simple coupler may be used for this example.  

 
Fig. 4.34 – Coupler Attachment Point Data For Example #3 

 Step 11: Because the Detailed Car has seven individual components each must be 

 connected with suspension elements. For this example we will use a total of 10 bushings 

 and 16 springs. Carefully copy the information from the images below as you create each 

 new element. Any small mistakes made here may result in the failure of your model to 

 run. 



 
 

 

   

 

   

   

 

 

 

   Bushing 1 Data       Bushing 2 Data               Bushing 3 Data 

   

 

 

   

 

 

 

 

   

 

   

Bushing 4 Data          Bushing 5 Data            Bushing 6 Data 

 

 

   

 

 



 
 

   

 

 

  

 

 

   

 

 

 

 

Bushing 7 Data           Bushing 8 Data             Bushing 9 Data 

 

 

 

 

 

 

 

 

 

 

 

    Bushing 10 Data 

 

 



 
 

  The spring elements can be made using the information from the next table. 

 

Fig. 4.35 – Example #3 Spring Element Data for Detailed Car 

 

 Step 12: For wheel/rail contact we will need to create a contact point for each wheel of 

 the Detailed Car for a total of eight contacts. The Contact Tab in the Data Entry Panel 

 will be utilized for this purpose. Copy the data from the Tab images for each contact 

 point and read the tips below.  

  Some things to note when creating contact points: 

  - Each wheelset (components 1-4) will have two contact points (one for each  

    wheel, right and left). 

  - The right rail is in the negative y direction from the s-axis and the left rail is in  

     the positive direction. 

  - ICSPL, JCSPL, and ICTJP alternate from 1, 2, 2 respectively for the right rail to  

    3, 3, 4 respectively for the left rail. 

  - ICREP should start at 1 and increase by one for each new contact point. 

  - S1 (Wheel) and S2 (Rail) also alternate between right and left for each contact  

     point.  

  - S1 (Rail) is the S-direction coordinate of the initial point of contact which is the  

    same as the S initial position of each wheelset. 

  - E (Wheel) and E (Rail) are both 21E10. 

 

   

 



 
 

 

   

 

 

   

 

 

 

 

 

 

 

 

 

          Contact #1 Data      Contact #2 Data 

 

 

 

 

 

 

 

 

   

   

 

 

 

 

 

  Contact #3 Data     Contact #4 Data 

 



 
 

 

 

   

 

 

 

 

 

 

Contact #5 Data     Contact #6 Data 

 

 

   

 

 

 

 

 

 

 

 

           Contact #7 Data                Contact #8 Data 

 



 
 

Step 13: Assign each railcar an S initial velocity of 16.976m/s. Do not forget to specify 

 this velocity for each of the seven components of the Detailed Car (Car 1). 

 Step 14: Check the Resistance Sub-Tab for Car 2 and Car 15 as their positions should be 

 assigned as Last Car and First Car, respectively, from the Car Location Dropdown 

 Menu. 

 

Fig. 4.36 – Example #3 Consist Graphic 

 Step 15: Determine which degrees of freedom you would like for each of the Detailed 

 Car’s components. DOFs may be changed in the Degrees of Freedom Sub-Tab within the 

 Cars Tab. This Sub-Tab can be seen in the image below. 

 

Fig. 4.37 – Degrees of Freedom Sub-Tab 

 Step 16: Open and Load an appropriate track file in the Track/Spline Tab, and enter 3 

 into the Track Curve Number data box.  

 Step 17: Make sure the Spline Functions check-box is checked then open the default 

 spline file (ATIFSPL.dat). Enter 4 into the Number of Spline Functions data box.  

 Step 18: Save the file (Ctrl + S) and run the simulation (Ctrl + Shift + R).  

 

 

 

 

 



 
 

APPENDIX 

General Data File 

AMS-Mode 

 0 

[Needs to be zero]  

============================================================================= 

2-Vehicle ATTIF Model 

[This block is irrelevant, but must include one line of text] 

============================================================================= 

 3  

Spatial-Analysis 

[This block is irrelevant, but must include two lines of text] 

============================================================================= 

 3  

Number-of-the-System-Degrees-of-Freedom 

[This block is irrelevant, but must include two lines of text] 

============================================================================= 

 6         0         1         0         0        0        0      500         

0 

[DOF]    [NUM] 

Initialization-Parameters 

[DOF signifies whether the simulation is single degree of freedom per vehicle  

(1 = longitudinal direction only) or it is using multiple degrees of freedom    

(6 = all six are available, see marker 16).  NUM indicates what numerical 

integrator to use (0=Adams, 1=Runge-Kutta). The meaning of the remaining 

integers is currently unknown.] 

============================================================================= 

 6         2    

[Marker] [NOE] 

Number-of-Bodies 

 Masses-and-mass-moments-of-inertia-of-the-bodies 

Vehicle_2 

 1            119295        306315        1632850       1536545    0    0    

0 

[body #]  [mass]    [Ixx]      [Iyy]   [Izz]     

[Ixy][Ixz][Iyz] 

Locomotive 

 2            166922        306315        1632850       1536545    0     0    

0 

Initial-coordinates 

Vehicle_2 

 1            0             0             2.5           0          0     0 

[body #]  [X]     [Y]       [Z]          []      []   [] 

[ = rotation about X axis,  = rotation about Z axis,  = rotation about Y 
axis] 

Locomotive 

 2            13.5          0             2.5           0          0     0 

Initial-velocities 

Vehicle_2        

 1            0             0             0             0          0     0 

[body #] [dX]       [dY]     [dZ]        [d]      [d]   [d] 
Locomotive 

 2            0             0             0             0          0     0 



 
 

Constant-forces-and-moments-acting-on-the-bodies 

Vehicle_2 

 1            0             0             -1170284      0          0     0 

[body #] [fX]        [fY]    [fZ]      [mX]      [mY]   [mZ] 

Locomotive 

 2            0             0             -1637504      0          0     0   

[Marker is the marker number (i.e. the above block uses INMARK6 subroutine 

for reading this data).  NOE is the number of elements listed in this block 

of data (i.e. data is being presented for 2 vehicles).  Note that Marker and 

NOE are listed at the beginning of every data block.  Although it is not 

necessary to have, the track can be set as body 1.  If this is the case, it 

needs some arbitrary mass. 

============================================================================= 

11            1  

Linear-Spring-Damper-Actuator-Elements 

Coupler_10_9 

 1            1             2             0             0              0  

[j]    [Body ibd]    [Body jbd]   [Not Used]    [Not Used]     [Not Used] 

 6            0            -1.624  -6            0       -1.624 

[Ux-ibd]   [Uy-ibd]       [Uz-ibd]    [Ux-jbd]      [Uy-jbd]         [Uz-

jbd] 

 1000000      10000         1.5           0 

  [Ks]        [Cd]      [L0]    [Force] 

[This simulates a spring-damper-force element.  IBD and JBD refer to the 

connected vehicles – JBD is in front of IBD WRT the positive X direction.  

The Ui dimensions are from the vehicle CG to the element connection point.  Ks 

is the elastic stiffness of the element.  Ca is the damping of the element.  

L0 is the un-deformed vehicle separation distance.  Force is the applied 

force.]  

============================================================================= 

16            2  

Generalized-Coordinate-Constraints 

Constraint_1 

 1  1  0  1  1  1  1 

 1 

[j] [body #]     [X]      [Y]       [Z]         []         []         

[] 
Constraint_2 

 1     2          0  0  1  1  1 

 1 

[These place positional constraints with respect to (WRT) the trajectory 

coordinate system.  This block is to be used when DOF is specified as 6 in 

the Initialization Parameters data block.  Note that 0=free and 

1=constrained.] 

============================================================================= 

 23            1  

Constant-Velocity-Constraints 

Constraint_1 

 1            2            1             2.78 

[j]      [body #] [Coordinate #]   [Velocity] 

[This places velocity constraints WRT the trajectory coordinate system.] 

============================================================================= 

 92  2 

Wheelset_Parameters 

Vehicle_2 

 1   1   4 



 
 

[j]     [body #]      [Number of Axles] 

 0.755  0.4572  5.024  0.00  -2.04  [Axle 1] 

 0.755  0.4572  3.296  0.00  -2.04  [Axle 2] 

 0.755  0.4572  -3.296 0.00  -2.04  [Axle 3] 

 0.755  0.4572  -5.024 0.00  -2.04  [Axle 4] 

 0.00   0.00   0.00  0.00  0.00   [Axle 5] 

 0.00   0.00   0.00  0.00  0.00   [Axle 6] 

[Width]       [Radius]      [Ux]       [Uy]        [Uz] 

Locomotive 

 2   2   6 

 0.755  0.4572  8.166  0.00  -2.04 

 0.755  0.4572  6.096  0.00  -2.04 

 0.755  0.4572  4.026  0.00  -2.04 

 0.755  0.4572  -4.026 0.00  -2.04 

 0.755  0.4572  -6.096 0.00  -2.04 

 0.755  0.4572  -8.166 0.00  -2.04 

[This data locates up to six axles per vehicle.  The width is the lateral 

distance from the axle center to the wheel/rail contact location.  The radius 

is the vertical distance from the axle center to the wheel/rail contact 

location. The Ui dimensions are from the vehicle CG to the axle center.] 

============================================================================= 

 93            2 

Vehicle-Characteristics-For-Resistance 

Vehicle_2               

 1           1  2 

[j]     [body #]  [2= last car,1=first car,0=middle car,3=only one 

car]    

 11.15  6.00  0.00  -0.25  [For the front face] 

[Area]       [Ux]         [Uy]         [Uz] 

 11.15  -6.00  0.00  -0.25  [For the rear face] 

Locomotive                 

 2           2  1    

 11.15  10.00  0.00  -0.25 

 11.15  -10.00 0.00  -0.25  

[This data locates the front and rear faces of each vehicle for aerodynamic 

drag considerations.  The area is the effective cross sectional area.  The Ui 

dimensions are from the vehicle CG to the effective area center.] 

============================================================================= 

94        1 

Locomotive-Tractive-Effort 

Locomotive 

 1        2  1       4         1      

[j]    [Body #]   [Loco ID]    [Notch]    [Reverser] 

 3000   0.5  100         

  

[Ramp Rate] [scaling factor] [threshold or ramping rate] 

[Loco ID specifies which type of locomotive to use.  Notch is the throttle 

position from 0-8.  Reverser controls the direction, -1, 0, or 1.  Ramp Rate 

is the most tractive effort (lb-force) to be increased per second.] 

============================================================================= 

 95        1 

Locomotive-Dynamic-Braking 

Locomotive 

 1      2      1       32      

[j]    [Body #]   [Loco ID]    [Notch] 

 6000   0.5  

[Ramp Rate]  [force fraction] 



 
 

[Loco ID specifies which type of locomotive to use.  Notch is the dynamic 

brake position from 0-256 (simulates infinite control).  Ramp Rate is the 

most braking effort (lb-force) to be increased per second.] 

============================================================================= 

 96        2 

Rail_Conditions 

Vehicle_2 

 1       1      0  0 

[j]    [Body #]   [Wet Rail] [Sanded Rail]      

 0.4          0.2      0.1  

[Dry u]    [Wet u]    [Sand du]  

Locomotive 

 2       2      0  0      

 0.4          0.2      0.1   

[The Wet Rail and Sanded Rail flags set the rail condition (1=true, 0=false). 

Dry and Wet u values are coefficients of friction, Sand du is the change due 

to sand presence.] 

============================================================================= 

 97        2 

Air_Brake_System_Data 

Consist 

 0  2  0 

[j]     [ILC]   [E-Brake]      

 70.0  0.0  0.0  400.0  900.0  254.0 

[OPR]      [Po]      [DPR]      [CSR1]  [CSR2]   [COMP CFM] 

 0.001625 0.003  0.00891 0.003  0.00891 0.00891 

[BCP Area] [ARP Area]  [BP Area]   [BVP Area]  [EVP Area] [CVP Area] 

 560.0 

[Air Temp]   

Vehicle_2 

 1  1      

[j]    [Body #]  

 0.04167 0.04167 83.33  0.579  1.447  0.5788 

[Gap]  [DEFo]     [BC K]     [BC Area]  [AR Volume]  [BC Volume] 

 0.5  10.0  50.0 

[COF]     [Rigging]  [BP Length]      

Locomotive 

 2  2      

 0.04167 0.04167  83.33  0.579  1.447  0.5788 

 0.5  10.0  50.0  

[This block specifies the air brake parameters for the #2 model (most 

recent).  The following is the data for the consist:  ILC is what body number 

controls the air brakes, E_Brake controls emergency braking (1=on, 0=off), 

OPR is the nominal operating pressure (psi), Po is the initial system 

pressure, DPR is the amount to reduce the brake pipe (i.e. pressure reduction 

to apply the brakes), CSR1&2 are the control signal propagation rates for 

normal charging/braking and for emergency braking, COMP CFM is the locomotive 

air compressor capacity in CFM, the (6) area values for the nominal flow 

areas for the 1. brake cylinder feed pipe, 2. auxiliary reservoir feed pipe, 

3. brake pipe, 4. normal braking vent pipe, 5. emergency braking vent pipe, 

and 6. the brake cylinder vent pipe, and the air temp refers to the nominal 

air temperature in the system (R).   

 

The following is the data for each vehicle:  Gap is the max gap between the 

brake pad and the wheel (ft), DEFo is the initial deformation of the brake 

cylinder spring, BC K is the brake cylinder spring stiffness, BC Area is the 

brake cylinder piston area, the (2) volumes are the dry volumes of the 



 
 

auxiliary reservoir and the brake cylinder (ft^3), COF is the coefficient of 

friction for the brake pad and wheel, Rigging is the leverage ratio for the 

linkage between the brake cylinder and the brake pad, and the BP Length is 

the effective length of the brake pipe.]       

    

============================================================================= 

98  1 

Vehicle_Coupler_Elements 

Coupler_2_1 

 1    1  2   10  0 

[j]    [Body ibd]  [Body jbd]   [Element ID]  [Failed] 

 6.00        0.00        -1.624  -6.00       0.00        -

1.624 

[Ux-ibd]     [Uy-ibd]     [Uz-ibd]     [Ux-jbd]    [Uy-jbd]     [Uz-

jbd]  

0.0254  1.50  239.70  5.90  0.00 

[Slack]       [L0]  [Kc]   [Kd]    [Strength] 

[This is for simulating realistic railroad vehicle connections.  IBD and JBD 

refer to the connected vehicles – JBD is in front of IBD WRT the positive X 

direction.  Element ID specifies the type of coupling element, 0, 1, 10, or 

20.  Failed indicates if the vehicles are disconnected (1=true, 0=false).  

The Ui dimensions are from the vehicle CG to the element connection point.  

Slack is the inherent element slack per vehicle (used for Element ID = 1, 10, 

and 20).  L0 is the un-deformed vehicle separation distance.  Kc refers to the 

elastic stiffness (1x109) of the vehicle chassis and Kd refers to the 

stiffness (1x109) of the drawbar (if used).  Strength specifies the ultimate 

breaking strength (1x103) of the coupler knuckle (used for Element ID = 10 and 

20).]  

============================================================================= 

 99  2 

Recorded_Operational_Control 

 Control_1 

 1   10   1   1   1 

[j]      [Time]      [Code]     [Element #]       [Value] 

Control_2 

 2   20   1   1   2 

[This is used for pre-programming the operation control points for a 

simulation.  In the future, the graphical interface will record all of the 

control changes that the user makes during a particular simulation.  These 

control points will then be written to this block of data to allow for the 

re-running of a simulation.  Time refers to the simulation time to make the 

change.  Code=1 indicates that the throttle notch will be updated, Code=2 

indicates that the dynamic brake notch will be updated, Code=3 indicates that 

the coupler status will be updated.  Element # refers to which element in the 

above data blocks to modify (i.e. for Code=1, a Element #=1 will change the 

throttle setting for the first locomotive listed in the marker 94 data 

block).  Value indicates what the new value will be.] 

============================================================================= 

130          1 

AIR_BRAKE_MODELS  

Air_brake_1 

 1       8 

[j]    [NOW] 

 0.01  0.01  1000.00 0.70    137895.1    1.25    0.50  0.50 

[Gap]       [L0]   [Kbc]  [Abc]      [P]    [Va]    [Vbc]   [WP u] 

 0.46  60.00  0.30 

[Radius]  [Inertia]    [WR u] 



 
 

[NOW specifies the number of braked wheels on each vehicle.  Gap is the 

maximum gap between the wheel and the brake pad.  L0 is the un-deformed length 

of the brake cylinder spring.  Kbc is the spring stiffness of the brake 

cylinder.  Abc is the area of the brake cylinder piston.  P is the brake pipe 
pressure reduction.  Vi are the volumes of the auxiliary reservoir and of the 

brake cylinder.  WP u is the coefficient of friction between the wheel and 

the brake pad.  Radius and Inertia are properties of the wheel.  WR u is the 

coefficient of friction between the wheel and the rail.] 

============================================================================= 

131         2  

Vehicle_Brakes 

Vehicle_2 

 1          1  1  

[j]      [Body #]    [Not Sure] 

 0.00  0.00  0.00  0.00 

[Ux]        [Uy]        [Uz]     [Not Used] 

Locomotive 

 1  2           1  

 0.00  0.00        0.00  0.00 

[The Ui dimensions are from the vehicle CG to the point of application.] 

============================================================================= 

 2             1  

Adams-Integration-Method 

 0           500    0.1 

[T0]   [Tf]        [Step] 

 0.00001  0.0001   0.00001 

 [Rel]  [Abs]       [Not Used]   

[T0 and Tf are the starting and ending simulation times.  Step is the time 

step used to print results.  Rel and Abs are the relative and absolute 

convergence tolerances.]     

============================================================================= 

 9             1 

[This block will open the samscrvt.dat file and proceed to read the track 

data.  The second number indicates which rail set(s) to use (i.e. 1 = use 

center curve data, 2 = use right rail data, and 3 = use left rail data.)]  

Curved-Track   

============================================================================= 

 1000          0  

[1000 specifies to stop reading the data file] 

End-of-the-Data-File 

 

[General Notes: 

1. The above data file is an example for a 2-vehicle simulation.  Note 
that some of the above markers should not be used with others (i.e. 

marker 98 and marker 11 both simulate vehicle connections). 

2. Any text in this document that is red, italic, and surrounded by 
brackets […] should be considered comments and not used in a real data 

file. 

3. The term “j” is an internal counter that is not used by the 
subroutines, but that must be there when shown above. 

4. All units are assumed to be in metric, unless stated otherwise] 

 

 



 
 

General Data File – Contact 

AMS-Mode 

 0 

[Needs to be zero]  

============================================================================= 

ATTIF-MODEL The suspended wheelset  

[This block is irrelevant, but must include one line of text] 

============================================================================= 

 3  

Spatial-Analysis 

[This block is irrelevant, but must include two lines of text] 

============================================================================= 

 11  

Number-of-the-System-Degrees-of-Freedom 

[This block is irrelevant, but must include two lines of text] 

============================================================================= 

 6       0      0       0       0       0      0      500      0      0.01 

[DOF]         [NUM]                                                  [CDIS] 

Initialization-Parameters 

[DOF signifies whether the simulation is single degree of freedom per vehicle  

(1 = longitudinal direction only) or it is using multiple degrees of freedom    

(6 = all six are available, see marker 16).  NUM indicates what numerical 

integrator to use (0=Adams, 1=Runge-Kutta). CDIS represents the allowable 

proximity distance between two contact points on each wheel. The meaning of 

the remaining integers is currently unknown.] 

============================================================================= 

2             1  

Adams-Integration-Method 

 0           10    0.001 

[T0]   [Tf]        [Step] 

 1E-06       1E-06                  1E-06 

 [Rel]  [Abs]       [Tol]   

[T0 and Tf are the starting and ending simulation times.  Step is the time 

step used to print results.  Rel and Abs are the relative and absolute 

convergence tolerances. Tol is the tolerance used in Newton iteration in 

finding the surface parameters.]     

============================================================================= 

 6         3    

[Marker] [NOE] 

Number-of-Bodies 

 Masses-and-mass-moments-of-inertia-of-the-bodies 

Rail  

 1             0             0            0              0         0     0    

0  

[body #]  [mass]    [Ixx]      [Iyy]   [Izz]     

[Ixy][Ixz][Iyz] 

Wheelset 

 2             1568          656           168           656       0     0    

0  

Frame 

 3             10000         1799          1799          2450      0     0    

0 Initial-coordinates 

Rail 

 1             0             0             0            0          0     0  

[body #]   [X]     [Y]       [Z]          []      []   [] 



 
 

[ = rotation about X axis,  = rotation about Z axis,  = rotation about Y 
axis] 

Wheelset 

 2             0             0          0.4566736441    0          0     0  

Frame 

 3             0             0          0.4566736441    0          0     0  

Initial-velocities 

Rail        

 1            0             0             0             0          0     0 

[body #] [dX]       [dY]     [dZ]        [d]      [d]   [d] 
Wheelset 

 2             15            1.1            0            0          0     

32.85 

Frame 

 3             15            0              0            0          0      0  

Constant-forces-and-moments-acting-on-the-bodies 

Rail 

  1          0             0                 0         0           0     0 

[body #] [fX]        [fY]    [fZ]      [mX]      [mY]   [mZ] 

Wheelset 

 2           0             0               -38000       0          0     0  

Frame 

 3           0             0                  0         0          0     0  

[Marker is the marker number (i.e. the above block uses INMARK6 subroutine 

for reading this data).  NOE is the number of elements listed in this block 

of data (i.e. data is being presented for 3 bodies).  Note that Marker and 

NOE are listed at the beginning of every data block.  Although it is not 

necessary to have, the track, as this example shows, can be set as body 1.  

If this is the case, it needs some arbitrary mass.] 

============================================================================= 

11            4  

Linear-Spring-Damper-Actuator-Elements 

Linear_Spring_1 

 1             2             3             0             0             0 

[j]    [Body ibd]    [Body jbd]   [Not Used]    [Not Used]     [Not Used] 

 0             0.9           0             0.1           0.9           0 

[Ux-ibd]   [Uy-ibd]       [Uz-ibd]    [Ux-jbd]      [Uy-jbd]         [Uz-

jbd] 

 13500         1000          0.1           0 

  [Ks]        [Cd]      [L0]    [Force] 

Linear_Spring_2 

 2             2             3             0             0             0              

 0             0.9           0             0             1             0  

 25000         0             0.1           0  

Linear_Spring_3 

 3             2             3             0             0             0              

 0            -0.9           0             0.1          -0.9           0  

 13500         1000          0.1           0  

Linear_Spring_4 

 4             2             3             0             0             0              

 0            -0.9           0             0            -1             0  

 25000         0             0.1           0 

[This simulates a spring-damper-force element.  IBD and JBD refer to the 

connected vehicles – JBD is in front of IBD WRT the positive X direction.  

The Ui dimensions are from the vehicle CG to the element connection point.  Ks 

is the elastic stiffness of the element.  Ca is the damping of the element.  



 
 

L0 is the un-deformed vehicle separation distance.  Force is the applied 

force.]  

============================================================================= 

16            3  

Generalized-Coordinate-Constraints 

RailGround 

 1      1         1           1           1           1           1           

1 

[j] [body #]     [S]      [Y]       [Z]         []         []         

[] 
Wheelset 

 2      2         0           0           0           0           0           

0 

Frame 

 3      3         0           1           1           1           1           

1  

[These place positional constraints with respect to (WRT) the trajectory 

coordinate system.  This block is to be used when DOF is specified as 6 in 

the Initialization Parameters data block.  Note that 0=free and 

1=constrained.] 

============================================================================= 

23            1  

Constant-Velocity-Constraints 

Constraint_1_For_Frame 

 1            3            1             15 

[j]      [body #]   [Coordinate #]   [Velocity] 

[This places velocity constraints WRT the trajectory coordinate system.] 

============================================================================= 

44            2  

Elastic-Contact-Method-I 

Contact_1 

 1           2          1          6          8          1          2          

1  

[j]     [Body ibd] [Body jbd] [ICMOD]    [JCMOD]    [ICSPL]    [JCSPL]    

[ICREP] 

 5           0          2 

[ITWOC]   [Not Used] [ICTJP] 

 0.0183644657245024          0             0             0.0236440460975024  

[S1W]                      [S2W]         [S1R]                 [S2R] 

 0.5            0.003 

[FriCof]     [Not Used] 

 0            -0.735         0             0             0             0  

[RXW]         [RYW]        [RZW]        [Not Used]    [Not Used]   [Not Used] 

 0            -0.755         0             0             0             0  

[RXR]         [RYR]        [RZR]        [Not Used]    [Not Used]   [Not Used] 

 0             0             0             0             0            -0.6943  

[Not Used]    [Not Used]   [Not Used]   [Not Used]    [Not Used]   [WCenter] 

Contact_2 

 2           2          1          6          8          3           4          

2              

 5           0          3  

-0.0183644657245024          0             0            -0.0236440460975024              

0.5            0.003  

 0             0.735         0             0             0             0  

 0             0.755         0             0             0             0  

 0             0             0             0             0             0.6943  



 
 

NCREP          2  

 1             1             1 

[j]          [ICRV]       [ICRV]           

 210000000000                210000000000         80000000000       

80000000000 

[EW]                         [ER]                 [GW]              [GR]                    

 0.3           0.3 

[PW]           [PR] 

 0             0             0             0             1.5708        0.5 

[Not Used][Not Used]    [Not Used]    [Not Used]         [Psi]    

[FlangeFriCof]     

 2             1             1  

 210000000000                210000000000         80000000000       

80000000000    

 0.3           0.3  

 0             0             0             0             1.5708        0.5  

ENDOC          0 

[End of this marker] 

[This block specifies the parameters used for elastic contact. The following 

is the data for the contact: [j] is the number of contact. [Body ibd] and 

[Body jbd] are the two bodies having contact; usually the first one is 

wheelset and the later one is rail. [ICMOD] and [JCMOD] indicate the method 

that will be used to define the profile of Wheel/Rail respectively and for 

current version the Spline is the only choice. [ICSPL] and [JCSPL] specified 

the Spline function number that will be used by Wheel/Rail respectively. 

[ICREP] is flag used to define the creep force model. [ITWOC] is the method 

used to evaluate the second point of contact (5=Quasi-Conformal, other values 

means using one point contact).[ICTJP] specifies which rail space curve will 

be used to evaluate contact information (1=center line, 2=right rail, 3=left 

rail). 

[S1W] and [S2W] are initial value of lateral and angular wheel surface 

parameters. [S1R] and [S2R] are initial value of longitudinal and lateral 

rail surface parameters. [FriCof] is the coefficient of friction of tread. 

[RXW], [RYW] and [RZW] are the X,Y,Z position of the origin of the surface 

coordinate system on the wheel WRT the body coordinate system. [RXR], [RYR] 

and [RZR] are the X,Y,Z position of the origin of the surface coordinate 

system on the rail WRT the body coordinate system. [Wcenter] is the lateral 

distance of the wheel center to the wheelset center of gravity. 

 

The following is the data for the creepage: [j] is the number of creepage 

model. [ICRV] is the creep force model which the user can refer to in the 

[ICREP]. [EW/R], [GW/R] and [PW/R] are the elastic modulus, shear modulus and 

Poisson ratio of the Wheel/Rail respectively. [Psi] is the angle between the 

normal planes that contain the 1/RRW (principle rolling radius of the wheel) 

and 1/RRR (principle rolling radius of the rail). [FlangeFriCof] is the 

coefficient of friction of the flange contact.] 

 

============================================================================= 

3             4  

Spline-Functions 

C:\Sams2000\Applications\ATTIF2000\ATIFSPL.DAT 

[This block specifies the directory of spline data used for the profiles of 

wheel and rail.] 

=============================================================================

9             3 



 
 

[This block will open the samscrvt.dat file and proceed to read the track 

data.  The second number indicates which rail set(s) to use (i.e. 1 = use 

center curve data, 2 = use right rail data, and 3 = use left rail data.)]  

Curved-Track   

=============================================================================                                             

 1000          0  

[1000 specifies to stop reading the data file] 

End-of-the-Data-File 

 

[General Notes: 

1. The above data file is an example for a suspended wheelset elastic 
contact simulation.  

2. Any text in this document that is red, italic, and surrounded by 
brackets […] should be considered comments and not used in a real data 

file. 

3. The term “j” is an internal counter that is not used by the 
subroutines, but that must be there when shown above. 

4. All units are assumed to be SI unit, unless stated otherwise] 

 


